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Concevoir plus rapidement des systéemes
de plus en plus flexibles et complexes

Rhapsody to generate uC low level code
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A standard software architecture for all products
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HWI is an hardware abstraction layer

= Standardized interface to access the hardware

* For a collection of objects with similar associate services (control,
read, write, ...)

— Digital inputs / outputs
— Analogical inputs / outputs (e.g ADC)
— Frequential inputs / outputs (e.g. PWM)

= Depending on hardware design, an implementation is
made by each project without reusing code (no real
standard, means tested, off the shelf)

=
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HWI typical implementation : hand made

vold FAR_FUNCTION HWI_ vidStart(void)
1

/¥ Ports Initialisation */

J® P32 on TOAABL #/

PMC3L |= BIT 2; /* Alternative mode */
PFCE3L &= ~BIT 2; /* Function 1..2 #/
PFC3L |= BIT_2; /* Function 2 */

/* P48 on SIB@ (CSIB) */

PMC4 |= BIT @; /* Alternative mode */
PFCE4 &= ~BIT_@; /* Function 1..2 #/
PFC4 &= ~BIT @; /* Function 1 */

/* P41 on SOB® (CSIB) */

PMC4A |= BIT 1; /* Alternative mode */
PFCE4 &= ~BIT 1; /* Function 1..2 #/
PFC4 &= ~BIT 1; /* Function 1 */

/* P42 on SCKB@ (CSIB) */

PMC4 |= BIT 2; /* Alternative mode */
PFCE4 &= ~BIT 2; /* Function 1..2 #*/
PFC4 &= ~BIT 2; /* Function 1 */
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An Opportunity for standardization :
Renesas (former NEC) uC product line at this time (2006)

» uC Series with same peripherals IP & several CPU (8 or 32 bits)

» In afamily, a derivative is made by instantiating existing bricks (IP):
— CPU : KO or V850
— Memories (ROM, RAM), several size
— Peripherals (TAA, TAB, UARTD, ...)

Table 1-1 V850ES/Fx3 features (2/2)

Serles name V850ES/FE3 V850ES/FF3 V850ES/FG3
Product ‘F33?'DA‘ ‘F3371 | ‘F3372 ‘ ‘F3373 | ‘F3374 ‘ ‘F3375 | ‘F3375A| ‘F3377A
A/D Converter 10 bits x 10 ch 10 bits x 12 ch 10 bits x 16 ch
UART/LIN 2ch 3ch | 5ch
Serial csl 2ch
interfaces ||| 1cl
CAN 1ch 2ch
DMA 4 cl
External
. 9ch 12 ch 13 ch
Interrupts | (incl. NMI)
Internal 48 ch 60 ch 65 ch

n? :_o #IBMSymposiumSystemes Jeudi 27 mars 2014 & 'IBM Client Center Paris
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Renesas C product line : idea of a standard was bo  rn

» Peripherals are reused within a family
— A software brick to manage a peripheral could be made
= Peripherals are instantiated n times for a derivative

— The software brick should be instanciable (same code running
several time with different set of data)

Commitment to design this standard with hand written code

= Result was an Heavy / difficult to understand software component
— Rhapsody has been used to reverse / understand the code

With lot of parts already in a Rhapsody model,
why not generating the code ?

Jeudi 27 mars 2014 & I'IBM Client Center Paris
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Basic concepts of the standard : it should be easy to use !

= Configuration driven by Hardware Schematics :
— What is the usage of the pin in my project ?

| use it like this by writing the minimum of code (1 line)

e . My, I (g | —F W LAET 1Py 1, 1§

P38/TrODD
-3

¥ | St

* P TIAAAL/-TORAALACTXDA

§ 3

/* Use P32 as Frequential output */

Pi n_UseAs @o@

=

H S #IBMSymposiumSystemes Jeudi 27 mars 2014 & I'IBM Client Center Paris



IBM Symposium Systemes 2014

Basic concepts of the standard continued
= Architecture based on physical objects
HARDWARE WORLD SOFTWARE WORLD

NECTAA

TAA (Timer/Event Counter)

&, Init(pstrDeviceConfig:tstrDeviceConfig)

NECTAB

TAB (Timer/Event Counter)

CSIB (Clocked Serial Interface)

UARTD (Asynch. Serial Interface)

i, Init(pstrDeviceConfig:tstrDeviceConfig)

NECCSIB

i, Init(pstrDeviceConfig:tstrDeviceConfig)

Jeudi 27 mars 2014 & I'IBM Client Center Paris
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V850 _pkg NECDEVICES pkg
- NECXXX_pk
Pin —PKg NECADC NECTAA
£b Init(bitinPortGroup: RhpUInt8=0) ! TAAQ:NECTAA ! CSBLNECCSIB
] UseAs (Mode:tD):void
s , . NECCSB NECTAB
k= Write1us(ugp:RpUint8):void 1 TABO:NECTAB 1 RCONECIC
= u16Read():RhpUInt16
NECIC NECUARTD
PORTDef_pkg
PG_0Def_pkg | PG_1Def_pkg NECTM
1 PO0:Pin 1 PO1:Pin 1 PO3:Pin 1 P10:Pin 1 P11:Pin
MCU_pkg RhpCOMMON_pkg CSTV850_pkg
«File» «Ty pe» «Ty pe» «File»
MCU a RhpBool RhpSInt16 DF3380
@ =] MCU_vidAtomicClearBit(Adres s:RhpUint8... Variablo Varable
- n . ; . . «Type» «Type» . . ¢ > .
: _ﬁ MCU_vidAtomicSetBit(Adress:RhpUInt8v... RhpSint32 RhpSints _ ACKDO:RhpStrin _ ACKEO:RhpStrin

#IBMSymposiumSystemes Jeudi 27 mars 2014 & 'IBM Client Center Paris 10
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The NECDEVICES_ pkg : classes for NEC Peripherals
NECDEVICES_pkg

NECADC NECTAA

€D Init(pstrDeviceConfig: tstrDeviceConfig)

= u16FRCRead():RhpUInt16

_hl ul6ReadFrequency(pul6Frequency:RhpUInt16p,p...
= u32FRCReadInMicroSec():RhpUInt32

NECIIC _ﬁ vidClose():void

_ﬁ VidFINOpen(ul6FrequencyMin:RhpUInt16,ul6Freq...
_ﬁ VidFOUTINHzDc16Write(ul6FrequencyValue:Rhp...

NECCSIB

NECTM = vidFOUTOpen(): wid
= VidFRCOpen():void
= VidHTControl (bStart:RhpBool,ul6TimerDuration:R...
NECUARTD = VidHTOpen(u8InterruptPriority Level: RhpUInt8):void
NECTAB

"
M
"
"
u
u
M
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«File»

N—

MCU a

_ﬁ MCU_vidAtomicClearBit(Adres s:RhpUint
_ﬁ MCU_vidAtomicSetBit(Adress:RhpUInt8v.

RhpCOMMON_ pkg
«Type» «Type»
RhpBool RhpSint16
«Type» «Type»
RhpSInt32 RhpSint8

CSTV850 pkg

MCU_pkg, RhpCOMMON_pkg, CSTV850 pkg : facilities
MCU_ pkg

«File»

DFE3380

«Variable»

_ACKDO:RhpStrint

«Variable»

«File»

_ACKEOQ:RhpStrin

DF3380IRQ

«File»

io_macros

«File»

DE3380extiO

#IBMSymposiumSystemes
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V850 pkg : the uC related package
V850 pkg
= NE CXXX_pkg

£D Init(bitihPortGroup: Rhp UINt8=0) 1 TAADNECTAA 1 CSBLNECCSB
= UseAs(Mode:tiD):void
= Write1lu8(u8p:RhpUInt8):void 1 TABONECTAB 1 2 CO:NECIC
= ul6Read():RhpUInt16

PORTDef pkg

PG_0ODef_pkg PG_1Def_pkg
1 P00:Pin 1 P0O1:Pin 1 P03:Pin 1 P10:Pin 1 P11:Pin

n? ? #I1BMSymposiumSystemes
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The Pin class at the heart of V850 pkg
Pin PortGroup

% Init (bitnPortGroup:Rhp UINt8=0) #a Init(pstrDeviceConfig:tstrDeviceConfig)

@ Read():RhpUInt8

& Write2u16(u16p1: RhpUInt16,u16p2:Rhp...

& Write1u8(u8p: RhpUint8):void

& Use As(Mode:tID):void 1 1

& DontUse():void itsPortGroup_:

1 1
itsF unctionl
Function
i, Init(pstrConfig: tstrC onfig)
itsFunction2
(:9 Function
: W Init(pstrConfig: tstrConfig)
14
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« Pin » , « Port Group » definitions from NEC

= Pin:
— “Denotes the physical pin. Every pin is uniquely denoted by its pin

number. A pin can be used in several modes. Depending on the
selected mode, a pin name is allocated to the pin.”

= Port Group :

— “Denotes a group of pins. The pins of a port group have a
common set of port mode control registers.”

=
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« Function » definition from NEC

= Function
— Port Mode
e “A pin in port mode works as a general purpose

Input/output pin. It is then called “port”. The
corresponding name is Pnm. For example, PO4 denotes

port 4 of port group 0. It is referenced as “port P04”.”

— Alternative Mode
* “In alternative mode, a pin can work in various non-
general purpose input/output functions, for example, as

the input/output pin of on-chip peripherals. The

corresponding pin name depends on the selected
function. For example, pin INTPO denotes the pin for

one of the external interrupt inputs. Note that for
example P03 and INTPO denote the same physical pin

The different names indicate the function in which the
pin is being operated.”

a? ? #IBMSymposiumSystemes
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Pin and functions in the Hardware Schematics

26

Functions

P31/RXDDB/INTPT /

)

The Pin

Pin number

ASCKDB/TOARABL1/TI PIPIBB)

used as a unique identifier because the pin number could be
different depending of the uC derivative (FE, FG, FF, ...)

=

Port Mode Name

H ? #IBMSymposiumSystemes
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Pin, Port Group, Function in the Software World
Pin PortGroup
s Init(bittnPortGroup:Rhp UInt8=0) i, Init(pstrDeviceConfig:tstrDeviceConfig)
@ Read():RhpUnt8 [ & tstrDeviceConfig
EWrite2u16(u16p1:RhpUInt16,u16p2:Rhp... EIE Attributes
& Write1u8(u8p: RhpUint8):void @ PFCERegisteraddress
& Use As(Mode:tiD):void 1 1 & PFCRegisterAddress
@ DontUse(): void itsPortGro up>l ]ﬂ PMCReqgisterAddress
& PMRegisterAddress
@ PRegister
1 <>1
itsFunctionl
Function
. . . €1 INTPn
&, Init (pstrConfig: tstrConfig) oF ANk
itsFunction2 &1 ToAAN
&% TOABNL
i LIn
= " | i LOn
unction _ :
-0 o R0 9 Mot
b, Init(pstrConfig:tstrConfig) ~ E-H Attributes ¢§ =
- alkernativeModevalue (RO) :
E pDevice (RO &1 TOABRZ
m tmmn &% TOABNS
18
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One line of code to use a pin, how it works ?
f = &ItsAvailableFunctions[8];
/* Search if the port has this function #*/
1 I £ 1 = ]
‘:{"hlle ((HFound) && (*F 1= NULL)) /* Use P32 as Frequential output */
1t *£)- trConfig->ID == Mod .
1 ((7f)->pstrConfig-> °de) | pi n_UseAs(&P32, TQAAN1):
Found = TRUE;
/* get port config for alternate mode from
function object and apply it on registers */
PFCE = {*‘F:} —:}pSt r'EIDﬂ'Fig i‘Fﬁ 1I:LFDIJI"ICIL . .
PFC = {*F)—}pStPEGHFig{
¥ /* Save used Mode and Device reference */
else me->mode = Mode;
{ /* Get the related DeviceModule from function object */
T me->pDevice = (*f)-»pstrConfig->pDevice;
/* Configure DeviceModule regarding to function */
ﬁ switch(Mode)
¢ q
: case TOAANn1:
: /* Shall open the TAA associated in FOUT mode */
1 : NECTAA vidFOUTOpen({NECTAA*)me->pDevice);

H ? #IBMSymposiumSystemes Jeudi 27 mars 2014 & 'IBM Client Center Paris 19
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V850 pkg : PORTDef pkg & NECXX_pkg
V850 pkg
NECXXX_pkg
€ Init(bitinPortGroup:RhpUInt8=0) + IAAGNECTAA ' CSIBLNECCSIB
= UseAs(Mode:tID):void
[ Write1u(u8p:RhpUInt8):void 1 TABO:NECTAB 1 ]2CO:NECIIC
= ul6Read():RhpUINt16
PORTDef pkg
PG_0Def pkg PG_1Def pkg
1 POO:Pin 1 PO1:Pin 1 PO0O3:Pin 1 P10:Pin 1 P11:Pin

=

&
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The NECXXX Package : instanciation of peripherals
NECXXX_pKg
1 TAAO:NECTAA 1 «ES_FJ3ES_FG3,ES_FK3,ste 1 TMMO:NECTM 1 UARTD3:NECUARTD
CSIBO:NECCSIB
1 TAA2:NECTAA 1 CSIB1:NECCSIB 1 ADCO:NECADC 1 TABO:NECTAB
1 TAAL:NECTAA 1 CSIB2:NECCSIB 1 TAB1:.NECTAB
1 TAA3:NECTAA 1 UARTDO:NECUARTD 1 TAB2:NECTAB
©
#IBMSymposiumSystemes
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PORTDef pkg Package : Port groups objects
PORTDef pkg
T i | J B | ]
PG _ODef_pkg PG_3Def_pkg PG_4Def_pkg PG_5Def_pk£;
1 | ] ]
PG_6HDef_pkg ‘ ‘ ‘ PG _9Def pkg |\ ‘ PG_DLDef pkg [\ ‘
] | | |
PG_CDDef pkg ‘ PG_CMDef_pkg/ . PG_CTDef pkg
‘ PG _CSDef pkg
|

PG_6LDef pkg

=

1

B
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A Typical object model for one Port Group

1 PG _0:PortGroup | T Po0PIn 1 TOAA31:Function
{
SPFCEQ, |1 PO1:Pin {
EPFCO, 2,
-EPI'I':D; TOAANL,
SPHMO, 1 P02:Pin ,;;;.‘;1311: -gave -e708 */f
&PO /*lint -restore %/
1 h
‘1 P03:Pin
1 PO4:Pin
1 PO5:Pin
©
: 1 PO06:Pin

#IBMSymposiumSystemes Jeudi 27 mars 2014 & 'IBM Client Center Paris 23
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Issues & solutions

Huge usage of RAM memory
By default Rhapsody stores objects & relations in RAM
The solution was provided by the support team

« A patch using properties to change the behavior of the code
generator to have objects & relations in ROM memory

* Now, integrated as a regular feature

Overhead in code size : slower execution @ runtime
ROM is more & more bigger in uC : this is acceptable

Long execution time at startup to configure the puC

A possible solution is to run the uC configuration off line and generate code
associated to registers value writing

(e.g change the behavior of “MCU_pkg” to have C code to embed instead of

=

]

writing registers)

n? 2 #IBMSymposiumSystemes Jeudi 27 mars 2014 & I'1BM Client Center Paris
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Benefits

= Cost reduction of HWI (Hardware abstraction layer) implementation
— From 500h of work to ~100h

= Code isin the street : Peugeot, Mercedes, VW, Skoda...

Jeudi 27 mars 2014 & I'IBM Client Center Paris
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Extension
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expanders over 12C bus

In innovation projects, extension has been made to manage 10

1 UPR 9532:PCA953x

>| 1 |2COPins:lICPins

1 HZP 9531:PCA953x

—

1 LCDLeft 9530:PCA953x

1 LCDRight 9530:PCA953x

1  TEMPLeft 9531:PCA953x

>
>

K—— 1 Radio 9532:PCA953x

.< 1 Radio 9635:PCA9635

E 1 Blower 9635:PCA9635

é 1 LPR1 9635:PCA9635

Jeudi 27 mars 2014 & I'IBM Client Center Paris
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